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Getting started
Set up your device

Your device uses a nano-SIM card (unless it is the Wi-Fi model). A SIM card may be
preinstalled, or you may be able to use your previous SIM card. Contact your service
provider for more details.

Install SIM/microsD cards

Place the SIM card and
optional microSD™ card
(sold separately) into
the tray with the gold
contacts facing down.

SIM

Charge your device
Before turning on your
device, charge it fully.
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Getting started

Charge the battery

Your device is powered by a rechargeable battery.

NOTE Wall charger sold separately. Use only Samsung-approved chargers and
cables. To avoid injury or damage to your device, do not use incompatible, worn
or damaged batteries, chargers or cables. Using other charging devices and
batteries may not be covered under warranty and may cause damage. For
more information on your device, including charging compatibility, please visit
samsung.com.

(Y- TIP While charging, the device and the charger may become hot and stop

= charging. This usually does not affect the device's lifespan or performance andis
inthe device's normalrange of operation. Disconnect the charger from the device
and wait for the device to cool down. For more information, visit

samsung.com/us/support/answer/ANS00076952.

Start using your device

Turn on your device

Use the Side key to turn your device on. Do not use the device if the body is cracked or
broken. Use the device only after it has been repaired.

2 Press and hold the Side key to turn the device on.

* To turn the device off, press and hold the Side and Volume down keys at the
same time, and tap @) Power off. Confirm when prompted.

* Torestart your device, press and hold the Side and Volume down keys at the
same time, and tap @ Restart. Confirm when prompted.


http://www.samsung.com/
http://www.samsung.com/us/support/answer/ANS00076952

Getting started

Use the Setup Wizard

The first time you turn your device on, the Setup Wizard guides you through the basics
of setting up your device.

Follow the prompts to choose a default language, connect to a Wi-Fi® network, set up
accounts, choose location services, learn about your device's features, and more.

Bring data from an old device

Download Smart Switch” to transfer contacts, photos, music, videos, messages, notes,
calendars, and more from your old device. Smart Switch can transfer your data using
a USB cable, Wi-Fi, or computer.

Visit samsung.com/smartswitch for more information.

1. From Settings, tap (@) Accounts and backup > Bring data from old device.

2. Follow the prompts and select the content to transfer.


http://www.samsung.com/smartswitch

Getting started

Lock or unlock your device

Use your device's screen lock features to secure your device. By default, the device
locks automatically when the screen times out. For more information about screen
locks, see Lock screen and security.

Side key

Press to lock.

Press to turn on
the screen, and
then swipe the
screen to unlock it.
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Getting started

Side key settings

You can customize the shortcuts assigned to the Side key.

Double press
Choose which feature is launched when the Side key is pressed twice.
1. From Settings, tap' .~ Advanced features > Side key.
2. Tap Double press to enable this feature, and tap an option:
* Quick launch camera (default)

« Openapp

Accounts

Set up and manage your accounts.

_‘Q’_ TIP Accounts may support email, calendars, contacts, and other features.
Contact your service provider for more information.

Add a Google Account

Sign in to your Google Account to access your Google Cloud Storage, apps installed
from your account, and make full use of your device’'s Android” features.

When you signin to a Google Account and set a Lock screen, Google Device
Protection is activated. This service requires your Google Account information when
resetting to factory settings. For more information, see

1. From Settings, tap {@J Accounts and backup > Manage accounts.
2. Tap=}= Add account > Google.

Add a Samsung account

Signin to your Samsung account to access exclusive Samsung content and make full
use of Samsung apps.

2+ From Settings, tap Samsung account.
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Getting started

Add an Outlook account

Sign in to your Outlook® account to view and manage email messages.

1. From Settings, tap () Accounts and backup > Manage accounts.
2. Tap=}= Add account > Outlook.

1



Getting started

Navigation
A touch screen responds best to a light touch from the pad of your finger or a

capacitive stylus. Using excessive force or a metallic object on the touch screen may
damage the surface of the screen and the damage will not be covered by the

warranty.

Tap

Lightly touch items to select or launch them.

« Tap anitem to selectit.

* Double-tap animage to zoom in or out.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Getting started

Swipe

Lightly drag your finger across the screen.
* Swipe the screen to unlock the device.

» Swipe the screen to scroll through the Home screens or menu options.

Drag and drop

Touch and hold an item, and then move it to a new location.

« Drag an app shortcut to add it to a Home screen.

« Drag a widget to place itin a new location.

Devices and software are constantly evolving — the illustrations you see here are for reference only.

13



Getting started

Zoom in and out

Bring your thumb and forefinger together or apart on the screen to zoom in and out.

» Move your thumb and forefinger apart on the screen to zoomiin.

» Move your thumb and forefinger together on the screen to zoom out.

Touch and hold

Touch and hold items to activate them.

» Touch and hold a field to display a pop-up menu of options.

 Touch and hold a Home screen to customize the Home screen.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Getting started

Navigation bar

You may navigate your device by using either the navigation buttons or full screen
gestures.

Search

> B O 0 o @

Calculator Calendar Camera Clock Contacts  Galaxy Store

N % Q8 m= PO

Gallery Game Internet Samsung Samsung Settings
Launcher Free Notes

Recent apps Back

Home

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Getting started

Navigation buttons

Use buttons along the bottom of the screen for quick navigation.

1. From Settings, tap (.= Display > Navigation bar > Buttons.

2. Tap an option under Button order to choose which side of the screen the Back
and Recent apps icons display.

3. Tap Button position to choose the position of the buttons on the Navigation bar.

Navigation gestures
Hide the navigation buttons at the bottom of the screen for an unobstructed screen
experience. Instead swipe to navigate your device.
1. From Settings, tap (.= Display > Navigation bar > Swipe gestures to enable the
feature.
2. Tap an option to customize:
» More options: Choose a gesture type and sensitivity.

» Gesture hint: Display lines at the bottom of the screen where each screen
gestureislocated.

— Switch apps when hint hidden: When gesture hint is disabled, you can still
switch between apps using the gesture when this option is enabled.

» Show button to hide keyboard: Show an icon on the bottom right corner of the
screen to hide the keyboard when the device is in portrait mode.

Customize your home screen

The Home screen is the starting point for navigating your device. You can place your
favorite apps and widgets here, in addition to setting up additional Home screens,
removing screens, changing the order of screens, and choosing a main Home screen.

App icons

Use app icons to launch an app from any Home screen.

o From Apps, touch and hold an app icon, and tap (+) Add to Home.
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Getting started

Toremove anicon:

¢+ From aHome screen, touch and hold an app icon, and then tap |11/ Remove.

NOTE Removing an icon does not delete the app, it just removes the icon from a
Home screen.

Wallpaper
Change the look of the Home and Lock screens by choosing a favorite picture, video,
or preloaded wallpaper.
1. From a Home screen, touch and hold the screen, and then tap >~ Wallpaper and
style.
2. Tap one of the following menus for available wallpapers:
* Tap the Lock screen and Home screen images to edit them.

* Change wallpapers: Choose from a variety wallpaper options, or download
more from Galaxy Themes.

* Color palette: Choose a palette based on colors from your wallpaper.

 Dim wallpaper when Dark mode is on: Enable to apply Dark mode to your
wallpaper.

Widgets
Add widgets to your home screens for quick access to info or apps.

1. Fromm a Home screen, touch and hold the screen.
2. Tap 55 Widgets, and then tap a widget set to openiit.

3. Swipe to the widget you want to add to the Home screen, and tap Add.
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Getting started

Customize Widgets

Once you have added a widget, you can customize where it's located and how it
functions.

2+ From a Home screen, touch and hold a widget, and tap an option:

Create stack: Add other widgets of the same size to stack in the same
place on the screen.

Remove: Delete a widget from your screen.
Settings: Customize the function or appearance of the widget.

App info: Review the widget usage, permissions, and more.

Home screen settings
Customize your Home and Apps screens.

1. Fromm a Home screen, touch and hold the screen.

2. Tap:os Settings to customize:

Home screen layout: Set your device to have separate Home and Apps
screens, or only a Home screen where all apps are located.

Home screen grid: Choose a layout to determine how icons are arranged on
the Home screen.

Apps screen grid: Choose a layout to determine how icons are arranged on
the Apps screen.

Add media page to Home screen: When enabled swipe right from the Home
screen to show a media page. Tap to view available media services.

Show Apps screen button on Home screen: Add a button to the Home screen
for easy access to the Apps screen.

Lock Home screen layout: Prevent items on the Home screen from being
removed or repositioned.

Add new apps to Home screen: Automatically add newly-downloaded apps
to the Home screen.

Hide apps on Home and Apps screens: Choose apps to hide from the Home
and App screens. Return to this screen to restore hidden apps. Hidden apps
are stillinstalled and can appear as results in Finder searches.
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Getting started

* App icon badges: Enable to show badges on apps with active notifications.
You can also choose the badge style.

- Swipe down for notification panel: Enable this feature to open the Notification
panel by swiping down anywhere on the Home screen.

* About Home screen: View version information.

* Contact us: Contact Samsung support through Samsung Members.
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Getting started

Status bar

The Status bar provides device information on the right side and notification alerts on
the left.

Statusicons

_ 4 N\ N

Battery full Charging Mute Vibrate
4 3 Q Q
Airplane mode Bluetooth active Location active Alarm

Notification icons

Ol 1 1 Be

New email Download Upload App update

Configure display options for the Status bar.

AT A

_‘Q’_ TIP From Quick settings, tap ¢ More options > Status bar to configure settings for
Status bar notifications.
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Getting started

Notification panel
For quick access to notifications, settings, and more, simply open the Notification
panel.

Fri, Mar 24 Device settings

Quick settings 6 Q 9 @

Device control Media output

Finish setting up your Galaxy Tab A7 Lite
Just a few more steps

Screenshot saved 1213pm
Tap here to see your screenshot.

Notification cards

@ USB for file transfer
o Charging

Notification settings

View the Notification panel
You can access the Notification panel from any screen.

1. Swipe down on the screen to display the Notification panel.

* Toopenanitem, tap it.
* To clear asingle notification, drag the notification left or right.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Getting started

* To clear all notifications, tap Clear.
* To customize notifications, tap Notification settings.

2. Drag upward from the bottom of the screen or tap ( Back to close the
Notification panel.

Quick settings

The Notification panel provides quick access to device functions using Quick settings.
The icons below show the most common settings available in Quick settings. Icon
colors change when enabled and disabled. Other settings may be available on your
device.
1. Drag the Status bar down to display the Notification panel.
2. Swipe down again from the top of the screen to display Quick settings.
* Tap a quick setting icon to turnit on or off.

* Touch and hold a quick setting icon to open the setting.

o O O @

Wi-Fi Sound Bluetooth Auto rotate
Airplane mode Location Power saving Dark mode

Quick settings options
The following options are available in Quick settings.

: Q Finder: Search the device.

: C) Power off: Power off and Restart options.

. Q Settings: Quickly access the device's settings menu.

- ¢ More options: Reorder Quick settings or change the button layout.

- Device control: Control other devices when supported apps like SsartThings or
Google Home are installed.
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- Media output: Access the Media panel and control playback of connected audio
and video devices.

- Brightness slider: Drag to adjust the screen brightness.

Modes and Routines

Set up modes and routines to automatically change your device's settings to match
your activity or situation.
¢+ From Settings, tap @ Modes and Routines for the following pages:
* Modes: Choose a mode based on what you are doing or where you are.

* Routines: Create routines for your device based on times or places.

Digital wellbeing and parental controls

You can monitor and manage your digital habits by getting a daily view of how
frequently you use apps, how many notifications you receive, and how often you
check your device. You can also set your device to help you wind down before going
to bed.

o+ From Settings, tap (©J Digital Wellbeing and parental controls for the following
features:

* Tap the Dashboard to view the following:
- Screen time: View how long an app has been opened and used each day.

- Notifications received: View how many notifications have been received
from an app each day.

- Times opened/Unlocks: View how many times an app has been opened
each day.

* Screen time goal: Set a screen time goal and view your daily average.
* App timers: Set a daily limit for how long you use each app.

* Driving monitor: Review your screen time while connected to your car's
Bluetooth and see which apps you use the most.

* Walking monitor: Review how much time you use your device while walking.
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Getting started

* Parental controls: Supervise your children’s digital life with Google's Family
Link app. You can choose apps, set content filters, keep an eye on screen
time, and set screen time limits.

Biometric security

Use biometrics to securely unlock your device and log in to accounts.

Face recognition

You can enable Face Recognition to unlock your screen. To use your face to unlock
your device, you must set a pattern, PIN, or password.

* Face recognition is less secure than Pattern, PIN, or Password. Your device could
e unlocked by someone or something that looks like your image.

- Some conditions may affect face recognition, including wearing glasses, hats,
beards, or heavy make-up.

- When registering your face, ensure that you are in a well-lit area and the camera
lens is clean.

1. From Settings, tap [(J) Security and privacy > Biometrics > Face recognition.

2. Follow the prompts to register your face.

Face recognition management

Customize how face recognition works.

- Remove face data: Delete existing faces.
* Face unlock: Enable or disable face recognition security.

* Stay on Lock screen until swipe: When you unlock your device with face
recognition, stay on the Lock screen until you swipe the screen.

* Brighten screen: Increase the screen brightness temporarily so that your
face can be recognized in dark conditions.

* About face recognition: Learn additional information about securing your
device with face recognition.
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Getting started

Biometrics settings

Configure your preferences for biometric security options.

o+ From Settings, tap o Security and privacy > Biometrics for the following:

* Show unlock transition effect: Show a transition effect when you use
biometrics to unlock your device.

* About unlocking with biometrics: Learn additional information about securing
your device with biometrics.
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Getting started

Tasklbar

Place the Taskbar on the bottom of your screen for a PC-like experience. Open apps
and app pairs quickly.

My Files Q
Recent files

Images

Videos

Audio files
Documents
Downloads
Installation files
Iqterngl storage

SD card

1 Trash

(@ Analyze storage

Edit menu layout

Shortcuts Recent apps

Apps list

l@ OO O 2o«

1. From Settings, tap | Display > Taskbar.
2. Tap( 1 to enable this feature.

* Show recent apps: Tap to show recently opened apps on the Taskbar.

Devices and software are constantly evolving — the illustrations you see here are for reference only.

26



Getting started

Multi window

Multitask by using multiple apps at the same time. Apps that support Multi window"™
can be displayed together on a split screen. You can switch between the apps and
adjust the size of their windows.

= APR Q
S M T w T F S
1
2 3 4 5 6 7 8
My event
9 10 11 12 13 14 15
My event
16 17 18 19 20 22
23 24 25 26 27 28 29
30
+
, Split screen control
< B Q :

O Go to the grocery store
O Do laundry
0O Call mom

PO OO*E ©® ©@ o<

1. Fromany screen, top| | |Recent apps.
2. Tap the app icon, and then tap Open in split screen view.
3. Tap an app in the other window to add it to the split screen view.

* Drag the middle of the window border to adjust the window size.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Window controls

The Window controls modify the way app windows are displayed in split screen view.

1. Drag the middle of the window border to resize the windows.
2. Tap the middle of the window border for the following options:
. Switch window: Swap the two windows.

. Add app pair to: Create and add an app pair shortcut to the Home screen
or Apps edge panel. It can also be added to the Taskbar.
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Edge panels

The Edge panels feature a variety of customizable panels that can be accessed from
the edge of the screen. Edge panels can be used to access apps, tasks, and contacts,
as well as view news, sports, and other information.

o From Settings, tap .= Display > Edge panels, tap to enable this feature.

Edge handle

Swipe to the center

‘ | ofthescreento
open the Edge
panels.

Apps panel
You can add apps to the Apps panel.

1. From any screen, drag the Edge handle to the center of the screen. Swipe until
the Apps panelis displayed.

2. Tap an app or app pair shortcut to open it. You can also tap « + All apps for the
complete app list.

» To open additional windows in pop-up view, drag the app icon from the Apps
panel to the open screen.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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To configure Apps panel:
1. From any screen, drag the Edge handle to the center of the screen. Swipe until

the Apps panelis displayed.
2. Tap , Edit to add other apps to the Apps panel.

* To add an app to the Apps panel, find it on the left side of the screen and tap it
to add it to an available space on the right column.

* To create a folder shortcut, drag an app from the left side of the screen on
top of an app in the columns on the right.

* To change the order of the apps on the panel, drag each app to the desired
location.

- Toremove an app, tap = Remove.

3. Tap < Back to save changes.

Configure Edge panels
You can customize the Edge panels.

1. From Settings, tap .+ Display > Edge panels > Panels.
2. The following options are available:
. Checkbox: Enable or disable each panel.
* Edit (if available): Configure individual panels.
« ¢ More options:
— Reorder: Change the order of the panels by dragging them to the left or
right.
— Hide on Lock screen: Choose panels to hide on the Lock screen when a
secure screen lock is set.
3. Tap < Back to save changes.
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Edge panel position and style
You can change the position of the Edge handle.

¢+ From Settings, tap ./ Display > Edge panels > Handle for the following options:

A

- [ { Edge handle: Drag to change the position of the Edge handle along the
edge of the screen.

* Position: Choose either Right or Left to set which side the Edge screen
displays on.

* Lock handle position: Enable to prevent the handle position from being
moved when touched and held.

* Style: Choose a color for the Edge handle.

* Transparency: Drag the slider to adjust the transparency of the Edge handle.
* Size: Drag the slider to adjust the size of the Edge handle.

* Width: Drag the slider to adjust the width of the Edge handle.

* Vibrate when handle is touched: Vibrate when the Edge handle is touched.

About Edge panels

You can view the current software version and license information for the Edge
panels feature.

o From Settings, tap (.= Display > Edge panels > About Edge panels.
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Enter text

Text can be entered using a keyboard or your voice.

g L &

O Go to the grocery store

®

©

Expand toolbar
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Toolbar

The toolbar provides quick access to features of the keyboard. Options may vary by
service provider.

- From the Samsung keyboard, tap <+« Expand toolbar for the following options:

Expression: Explore different types of emoijis, GIFs, create custom
combined emojis, and more.

Clipboard: Access the clipboard.

Standard keyboard: Change the keyboard from a split version that is
separated on either side of the fold, to a standard keyboard that stretches
across both sides.

]2 Hanawriting: Use your handwriting to enter text.
U/ voice input: Use Samsung voice input.
Settings: Access keyboard settings.
Split keyboard: Change the keyboard to a split version that is separated.

Floating keyboard: Change the keyboard to a floating version that can be
moved anywhere on the screen.

Search: Locate specific words or phrases in your conversations.

Translate: Type words or sentences in the keyboard to translate them
into another language.

Grammarly: Get suggestions from Grammarly as you type.
Spotify: Add music from Spotify .
YouTube: Add videos from YouTube.
< EmoaQjis: Insert an emoaiji.
GlIFs: Add animated GiFs.
G‘_] Bitmoji: Create your own personal emoji and use it in stickers.
»  Mojitok: Create your own stickers or insert automatically suggested ones.
C} Keyboard size: Adjust the height and width of the keyboard.

<:> Text editing: Use an editing panel to help pinpoint text that you want to
cut, copy, and paste.
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Configure the Samsung keyboard

Set customized options for the Samsung keyboard.

¢+ From the Samsung keyboard, tap ¢ o Settings for the following options:

Languages and types: Set the keyboard type and choose which languages
are available on the keyboard.

- To switch between languages, swipe the Space bar left or right.

Smart typing

Predictive text: As you type see suggested words and phrases.

sSuggest emajis: Include emojis when using predictive text.

sSuggest stickers while typing: View recommended stickers while you are
typing.

Auto replace: Automatically replace what you type with predictive text
recommendations.

Suggest text corrections: Underline misspelled words in red and suggest
corrections.

Text shortcuts: Create shortcuts for frequently used phrases.

More typing options: Customize additional typing options.

Style and layout

Keyboard toolbar: View or hide the keyboard toolbar.

High contrast keyboard: Adjust the size of the Samsung keyboard and
change its colors to increase the contrast between the keys and the
background.

Theme: Choose a theme for your keyboard.

Mode: Choose between portrait and landscape mode.

Size and transparency: Adjust the size and transparency of the keyboard.
Layout: Display numbers and special characters on the keyboard.

Font size: Drag the slider to adjust the font size.
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Other settings

Voice input: Configure voice input services and settings.
Swipe, touch, and feedback: Customize gestures and feedback.
Handwriting: Customize handwriting options.

Save screenshots to clipboard: Enable saving screenshots to the keyboard
clipboard.

Select third-party content to use: Enable third-party keyboard features.

Reset to default settings: Return keyboard to original settings and clear
personalized data.

About Samsung keyboard: View version and legal information for the
Samsung keyboard.

Contact us: Contact Samsung support through Samsung Members.
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Use Samsung voice input
Instead of typing, enter text by speaking.

o From the Samsung keyboard, tap \9} Voice input and speak your text.

< s O B8
B L L QO ® - A 3T @
O Go to the grocery store
O Do laundry
O Callmom
® = == B I U FT I @ 12v =+ =
< Voiceinput
Tap to talk
Return to keyboard —— < ey > , @ J
N QO v i
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Camera and Gallery

You can capture high-quality pictures and videos using the Camera app. Images and
videos are stored in the Gallery, where you can view and edit them.

PORTRAIT PHOTO VIDEO  MORE

POOO 06 O o
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Camera and Gallery

¢) Camera

You can capture high-quality pictures and videos using the Camera app.
& From Apps, tap () Camera.

_‘Q’_ TIP Quickly press the Side key twice to open the Camera app.

A5 A

Settings

Switch cameras
Zoom Capture

Gallery

PORTRAIT  PHOTO  VIDEO  MORE Shoot|ng modes

POOORE @ @ o<
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Navigate the camera screen

Take stunning pictures with your device's front and rear cameras.

1. From @ Cameraq, set up your shot with the following features:
* Tap the screen where you want the camera to focus.

— When you tap the screen, a brightness scale appears. Drag the slider to
adjust the brightness.

* To quickly switch between the front and rear cameras, swipe the screen up
or down.

* Tozoom at a precise level, tap X and tap an option at the bottom of the
screen. (Only available when using the rear camera.)

* To change to a different shooting mode, swipe the screen right or left.
« To change camera settings, tap :0¢ Settings.
2. Tap( | Capture.

Configure shooting mode

Allow the camera to determine the ideal mode for your pictures or choose from
several shooting modes.
o From (£) Camera, swipe the screen right and left to change shooting modes.
* Portrait: Adjust the background of your shots for portrait photos.
* Photo: Allow the camera to determine the ideal settings for pictures.

* Video: Allow the camera to determine the ideal settings for videos.

+ More: Choose other available shooting modes. Tap -+ Add to drag modes
into or out of the shooting modes tray at the bottom of the Camera screen.

- Deco Pic: Decorate photos or videos in real time with the camera.

- Pro: Manually adjust the ISO sensitivity, exposure value, white balance, and
color tone while taking pictures.

- Food: Take pictures that emphasize the vivid colors of food.
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Camera and Gallery

- Panorama: Create alinear image by taking pictures in either a horizontal
or vertical direction.

- Hyperlapse: Create a time lapse video by recording at various frame rates.
The frame rate is adjusted depending on the scene being recorded and
the movement of the device.

Record videos

Record smooth lifelike videos using your device.

1. From @ Camera, swipe right or left to change the shooting mode to Video.
2. Tap e Record to beginrecording a video.
« To take a picture while recording, tap( = Capture.

« To temporarily stop recording, tap I Pause. To continue recording,
tap ¢ Resume.

3. Tap = Stop when you are finished recording.

Camera settings
Use the icons on the main camera screen and the settings menu to configure your
camera'’s settings.

o From @ Camera, tap (O} Settings for the following options:

Intelligent features

* Scan QR codes: Automatically detect QR codes when using the camera.

Pictures

* Swipe Shutter button to: Choose to either take a burst shot or create a GIF
when you swipe the shutter to the nearest edge.
* Watermark: Add a watermark to the bottom left corner of your pictures.
Selfies
* Save selfies as previewed: Save selfies as they appear in the preview without
flipping them.
* Selfie color tone: Set the color tone for your selfies to Natural or Bright.
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General

Grid lines: Display viewfinder grid lines to help compose a picture or video.
Location tags: Attach a GPS location tag to your pictures and videos.
Shooting methods:

- Press Volume keys to: Use the Volume keys to take pictures, record video,
zoom, or control system volume.

- Floating shutter button: Add an extra shutter button that you can move
anywhere on the screen.

- Show palm: Hold your hand out with your palm facing the camera to have
your picture taken in a few seconds.

Settings to keep: Choose whether to launch Camera with the same shooting
mode, selfie angle, and filters as the last time.

Storage location: Choose a location to store pictures and videos.
- A microSD card (not included) must be installed to view Storage location.

Shutter sound: Play a tone when taking a picture.

Privacy

« Privacy Notice: View Samsung's privacy information.

» Permissions: View required and optional permissions for the Camera app.

Others

» Reset settings: Reset the Camera settings.

» About Camera: View app and software information.

« Contact us: Contact Samsung support through Samsung Members.
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€ Gallery

Go to the Gallery to look at the all the visual media stored on your device. You can
view, edit, and manage pictures and videos.

o From Apps, tap @ Gallery.

View pictures |

and videos |
sortimagesinto | °
custom albums
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Pictures

Albums

Stories

Videos

Favorites

Recent
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Shared albums

Trash
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Customize collections
of pictures and videos
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View pictures

Pictures stored on your device are viewable in the Gallery app.

1. From €) Gallery, tap Pictures.
2. Tap a picture to view it. Swipe left or right to view other pictures or videos.
- Tomark the picture as a favorite, tap Add to Favorites.

« To access the following features, tap ¢ More options:

Details: View and edit information about the picture.

Copy to clipboard: Copy the image to paste in another app.
— Set as wallpaper: Set the picture as wallpaper.

Print: Send the picture to a connected printer.

Edit pictures
Enhance your pictures using the Gallery's editing tools.
1. From € Gallery, tap Pictures.

2. Tap apicture to view it, and then tap ( Edit for the following options:

. Auto adjust: Apply automatic adjustments to improve the picture.

Transform: Rotate, flip, crop, or make other changes to the overaill
appearance of the picture.
Filters: Add color effects.

Tone: Adjust the brightness, exposure, contrast, and more.

Decorations: Add text, stickers, or hand drawn content.

More options: Access additional editing features.

* Revert: Undo the changes applied to restore the original picture.

3. Tap Save when finished.
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Play video

View the videos stored on your device. You can save videos as favorites, and view
video details.
1. From € Gallery, tap Pictures.

2. Tap avideo to view it. Swipe left or right to view other pictures or videos.

« Tomark the video as a favorite, tap Add to Favorites. The video is added to
Favorites under the Aloums tab.

« To access the following features, tap ¢ More options:
— Details: View and edit information about the video.
— Set as wallpaper: Set the video as wallpaper on the Lock screen.
3. Tap | » to play the video.

Edit video

Edit videos stored on your device.

1. From € Gallery, tap Pictures.

2. Tap avideo to view it.

3. Tap £/ Edit to cut segments of the video.
4,

Tap Save, and then confirm when prompted.

Share pictures and videos
Share pictures and videos from the Gallery app.
1. From @) Gallery, tap Pictures.

2. Tap : More options > Edit and select the pictures or videos you want to share.

3. Tap < Share, and then choose an app or connection to use for sharing your
selection. Follow the prompts.
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Delete pictures and videos

Delete pictures and videos stored on your device.

1. From ) Gallery, tap ¢ More options > Edit.

2. Tap pictures and videos to select them.
3. Tap || Delete, and confirm when prompted.

Take a screenshot

Capture animage of your screen. Your device will automatically create a Screenshots
album in the Gallery app.

2: From any screen, press and release the Side and Volume down keys.

Palm swipe to capture a screenshot
Capture animage of the screen by swiping the edge of your hand across it, from side
to side, keeping in contact with the screen.
1. From Settings, tap| = Advanced features > Motions and gestures > Palm swipe to
capture.

2. Tap to enable this feature.

Screenshot settings

Modify screenshot settings.

: From Settings, tap | = Advanced features > Screenshots.

» Show toolbar after capturing: Show additional options after you take a
screenshot.

« Delete after sharing from toolbar: Automatically delete screenshots after
they are shared through the screenshot toolbar.

+ Hide status and navigation bars: Do not display the status bar or navigation
bbars on screenshots.

» Format: Choose if you would like your screenshots to be saved as JPG or
PNG files.

 Save screenshots in: Choose a storage location for your screenshots.
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AppPS
Using apps

The Apps list displays all preloaded and downloaded apps. Apps can be downloaded
from Galaxy Store and the Google Play” store.

< From a Home screen, swipe the screen upward to access the Apps list.

Uninstall or disable apps

Installed apps can be removed from your device. Some apps that are preloaded
(available on your device by default) can only be disabled. Disabled apps are turned
off and hidden from the Apps list.

2: From Apps, touch and hold an app, and tap Uninstall/Disable.

Search for apps

If you are not sure where to find an app or a setting, you can use the Search feature.

1. From Apps, tap Search, and enter a word or words. As you type, matching apps
and settings appear as results on the screen.

2. Tap aresult to go to that app.

_‘Q’_ TIP You can customize the search settings by tapping : More options > Settings.

Sort apps

App shortcuts can be listed alphabetically or in your own custom order.

o From Apps, tap ¢ More options > Sort for the following sorting options:
* Custom order: Arrange apps manudally.

* Alphabetical order: Sort apps alphabetically.
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Create and use folders

You can make folders to organize App shortcuts on the Apps list.
1. From Apps, touch and hold an app shortcut, and then drag it on top of another
app shortcut until it is highlighted.
2. Release the app shortcut to create the folder.
* Folder name: Name the folder.
- (Palette: Change the folder color.

. Add apps: Place more apps in the folder. Tap apps to select them, and
then tap Done.

3. Tap< Back to close the folder.

Copy a folder to a Home screen

You can copy a folder to a Home screen.

o From Apps, touch and hold a folder, and tap (4] Add to Home.

Delete a folder

When you delete a folder, the app shortcuts return to the Apps list.

1. From Apps, touch and hold a folder to delete.
2. Tap || Delete folder, and confirm when prompted.

Game Booster

Get optimized performance while playing games based on your usage. Block
notifications and enable features to improve your gaming experience.

2 While playing a game, swipe up from the bottom of the screen to view the
navigation bar. The following options are seen on the far right and left sides:
. Touch protection: Lock the screen to prevent accidental taps. This is
the default option.
. Game Booster: Configure other options, including performance

monitoring and blocking the navigation bar, screen touches, and
screenshots.
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App settings
Manage your downloaded and preloaded apps.
o From Settings, tap (41 Apps. Tap an option to customize:

 Choose default apps: Choose which apps to use for making calls, sending
messages, going to websites, and more.

* Samsung app settings: View a list of Samsung apps and customize their
settings.

* Your apps: Tap an app to view and update information about its privacy and
usage settings. Options vary by app.

_‘q'?’_ TIP To reset app options that have been changed, tap : More options > Reset app

AT A

preferences.

Samsung apps

The following apps may be preloaded or downloaded over-the-air to your device
during setup. Apps can be downloaded from Galaxy Store and the Google Ploym store.
Options may vary by service provider.

@ Galaxy Store

Find and download premium apps that are exclusive to Galaxy devices. A Samsung
account is required to download from Galaxy Store.

@ Game Launcher

Automatically arrange all your games in one place. For more information on Game
Launcher, visit samsung.com/us/support/owners/app/game-launcher.

N

_Q’_ TIP If Game Launcher is not seen in the Apps list, then from Settings, tap
Advanced features > Game Launcher, and then tap
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@ Samsung Flow

Connect your phone and tablet with Samsung Flow. You can then view notifications
and reply to messages from your phone on your connected tablet. You can also use
Mobile hotspot to access the Internet on your tablet through your phone’s network
connection when other networks are not available.

For more information, visit samsung.com/us/support/owners/app/samsung-flow.

@ Samsung Free

Access live TV shows, news and articles from numerous sources, and interactive
games entirely free of charge.

0 Somsung Members

Get more and do more from your Galaxy device. Enjoy DIY support tools and exclusive
experiences and content — for Samsung members only. Samsung Members may be
preloaded on your device, or you can download and install it from Galaxy Store or the
Google Play store.

@ scrmsung TV Pls

Enjoy free news, entertainment, and more on your Samsung TV and mobile devices.
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€D calculator

The Calculator app features both basic and scientific math functions, as well as a unit
converter.

816x4 History
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—— View past

calculations.

Clear history
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Ii— Convert between
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sin cos tan 7 8 9 X
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() calendar

The Calendar app can be connected to your various online accounts to consolidate
all your calendars in one place.

Navigation drawer ——= a @—— Go to today’s date
MAR |—— Search
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Add calendars

Add your accounts to the Calendar app.

1. From (©) Calendar, tap — Navigation drawer.
2. Tap Manage calendars >—— Add account and select an account type.

3. Enter your account information and follow the prompts.

.‘Q’. TIP Accounts may also support email, contacts, and other features.

Calendar alert style
Alerts from the Calendar app can be set to different styles.
1. From G Calendar, tap — Navigation drawer > Calendar settings > Alert style.
The following options are available:
* Light: Receive a notification and hear a short sound.
* Medium: Get a full screen alert and hear a short sound.
* Strong: Get a full-screen alert and ring sound that persist until dismissed.

2. Depending on the alert style selected above, the following sound options are
available:

* Short sound: Choose the alert sound for Light or Medium alert styles.

* Long sound: Choose the alert sound for the Strong alert style.

Creqate an event

Use your Calendar to create events.

1. From (7) Calendar, tap -}~ Add detailed event to add an event.

2. Enter details for the event, and then tap Save.

Delete an event

Delete events from your Calendar.

1. From 0 Calendar, tap an event, and tap again to edit it.

2. Tap || Delete, and confirm when prompted.
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The Clock app offers features for keeping track of time and setting alarms.
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Alarm

Use the Alarm tab to set one-time or recurring alarms and choose options for how to
e notified.

1. From () Clock, tap —|- Add alarm.

2. Tap the following items to configure an alarm:

Time: Set a time for the alarm.
Day: Choose the days for this alarm.
Alarm name: Enter a name for the alarm.

Alarm sound: Choose a sound to play for the alarm and drag the slider to set
the volume of the alarm.

Vibration: Choose whether the alarm uses vibration alert.

Snooze: Allow snoozing. Set interval and repeat values for the alarm while
snoozing.

3. Tap Save to save the alarm.

_‘Q’_ TIP To add your sleep schedule, create a bedtime reminder, and automatically
put your device in Sleep mode, tap ¢ More options > Set Sleep mode schedule.

Delete an alarm
You can delete an alarm that you created.

1. From Q Clock, touch and hold an alarm.

2. Tap || Delete.

Alert settings

You can set the device to vibrate for alarms and timers whether the Sound mode is
set to Mute or Vibrate.

1. From (1) Clock, tap ¢ More options > Settings.

2. Tap Silence alarms when system sound is off to enable the feature.
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Alarm settings

You can receive notifications for upcoming alarms.

1. From (1) Clock, tap ¢ More options > Settings.

2. Tap Upcoming alarm notification to choose the number of minutes before an
upcoming alarm.
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World clock

The World clock lets you keep track of the current time in multiple cities around the
globe.

Search
< Add city Q— Find a particular
» = place.

Globe

Drag to spin and
see times around
the world.

City
View the current

Denver

] time and add to

your list of cities.

Location
Center the globe on
your current location.

= Q00O Ao«

1. From (1) Clock, tap World clock.
2. Tap—}- Add city.

3. Drag the globe to spinit, tap the city you want, and then tap Add.
« Toremove a city, touch and hold it, and tap {E]' Delete.

Devices and software are constantly evolving — the illustrations you see here are for reference only.
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Time zone converter
Set atime in a city on your World clock list to see what the local times would be in the
other listed cities.
1. From (1) Clock, tap World clock.
2. Tap ¢ More options > Time zone converter.
3. Tap W Menu to choose a different city.
« To add acity to the list, tap —— Add city.

4. Swipe the hours, minutes, and period (AM or PM) on the clock to set a time. Local
times for the other cities listed are automatically updated.

* Toreturn the clock to the current time, tap Reset.

Weather settings

Show weather information on your World clock.

1. From (1) Clock, tap World clock.

2. Tap : More options > Settings > Show weather to enable or disable weather
information.

3. Tap Temperature to change from Fahrenheit to Celsius.

Stopwatch

The Stopwatch lets you time events down to a hundredth of a second.

1. From (1) Clock, tap Stopwatch.
2. Tap Start to begin timing.
* To keep track of lap times, tap Lap.
3. Tap Stop to end timing.
* To continue timing after stopping the clock, tap Resume.

* Toreset the Stopwatch to zero, tap Reset.
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Timer

Set a countdown timer for up to 99 hours, 59 minutes, and 59 seconds.

1. From (1) Clock, tap Timer.
2. Use the keypad and tap Hours, Minutes, and Seconds to set the Timer.
3. Tap Start to begin the Timer.

* To temporarily stop the Timer, tap Pause. To continue, tap Resume.

* To stop and reset the Timer, tap Delete.

Preset timer

Name and save preset timers.

1. From (1) Clock, tap Timer > ¢ More options > Add preset timer.
2. Configure the countdown time and timer name.
3. Tap Add to save the timer.

« To edit asaved preset timer, tap ¢ More options > Edit preset timers.

Timer options

You can customize the Timer options.

1. From Q Clock, tap Timer.

2. Tap : More options > Settings.
* Sound: Choose a preloaded timer sound or add your own.
* Vibration: Enable vibration for the timer.

* Show mini timer: Show a pop-up window of the timer when the Clock app is
mMinimized.
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Other settings

View and configure settings for all Clock tools.
o From Q Clock, tap ¢ More options > Settings.
* Permissions: View required and optional permissions for the Clock app.

* Contact us: Contact Samsung support through Samsung Members.

* About Clock: View the current software version and check for updates.
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6 Contacts

Store and manage your contacts. You can synchronize with personal accounts

added to your device. Accounts may also support email, calendars, and other
features.
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Create a contact
1. From {3 Contacts, tap -~ Create contact.

2. Enter details for the contact, and then tap Save.

Edit a contact
When editing a contact, you can tap a field and change or delete information, or you
can add more fields to the contact's list of information.

1. From ({3 Contacts, tap a contact.

2. Tap £/ Edit.

3. Tap any of the fields to add, change, or delete information.

4. Tap Save.

Favorites
When you mark contacts as favorites, they are grouped at the top of your contact list
and easily accessible from other apps.

1. From (3 Contacts, tap a contact.

2. Tap Favorites to mark the contact as a favorite.

« Toremove the contact from Favorites, tap 7  Favorites.

Share a contact
Share a contact with others by using various sharing methods and services.

1. From ({3 Contacts, tap a contact.
2. Tape_ Share.
3. Tap either vCard file (VCF) or Text.

4. Choose asharing method and follow the prompts.

Y- TIP When viewing a contact, tap : More > QR code to quickly share the

information with friends or family. The QR code automatically updates when you
change the contact information fields.
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Show contacts when sharing content

Share content directly with your contacts from within any app. Once enabled, your
frequent contacts are displayed in the Share window.

: From Settings, tap | -~ Advanced features > Show contacts when sharing content,
and tap to enable the feature.

Groups
You can use groups to organize your contacts.

Create agroup

Create your own contact groups.

1. From ({3 Contacts, tap — Show navigation menu > Groups.
2. Tap Create group, and then tap fields to enter information about the group:
* Group hame: Enter a name for the new group.
* Add member: Select contacts to add to the new group, and then tap Done.

3. Tap Save.

Add or remove group contacts

Add more contacts to a group, or remnove contacts.

: From {{J) Contacts, tap — Show navigation menu > Groups, and then tap a group.

* Toremove a contact, touch and hold a contact to select it, and then tap
Remove.

« To add a contact, tap £ Edit > Add member, and then tap the contacts you
want to add. When finished, tap Done > Save.
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Send an email to a group
Send an email to members of a group.

1. From {3 Contacts, tap — Show navigation menu > Groups, and then tap a group.
2. Tap ¢ More options > Send email.

3. Tap contacts to select them, or tap the All checkbox at the top of the screen to
select all, and then tap Done.

* Only group members that have an email address in their records are
displayed.
4. Choose an email account and follow the prompts.

Delete a group
Delete a group you have created.
1. From {3 Contacts, tap — Show navigation menu > Groups, and then tap a group.
2. Tap : More options > Delete group.
* Toonly delete the group, tap Delete group only.

* To delete the group and the contacts in the group, tap Delete group and
move members to the trash.

Manage contacts

You canimport or export contacts, as well as link multiple contacts into one contact
entry.

Merge contacts

Consolidate contact information from multiple sources into one contact by linking
entries into a single contact.

1. From {{J) Contacts, tap — Show navigation menu > Manage contacts.

2. Tap Merge contacts. Contacts with duplicate phone numbers, email addresses,
and names will be listed together.

3. Tap the contacts to select them, and tap Merge.
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Import contacts
Import contacts to your device as vCard files (VCF).

1. From () Contacts, tap — Show navigation menu > Manage contacts.

2. Tap Import contacts and follow the prompts.

Export contacts

Export contacts from your device as vCard files (VCF).

1. From () Contacts tap — Show navigation menu > Manage contacts.

2. Tap Export contacts and follow the prompts.

Sync contacts
Keep all of your contacts up to date in all of your accounts.

1. From {{J) Contacts tap — Show navigation menu > Manage contacts.

2. Tap Sync contacts.

Delete contacts

Delete a single contact or multiple contacts.

1. From ({3 Contacts, touch and hold a contact to select it.

* You can also tap other contacts to select them for deletion.
2. Tap || Delete, and confirm when prompted.
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Samsung Internetis a simple, fast, and reliable web browser for your device.
Experience more secure web browsing features that allow you to browse faster,
protect your privacy, and enhance your browsing experience.
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TIP Visit samsung.com/us/support/owners/app/samsung-internet for more
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Browser tabs

Use tabs to view multiple webpages at the same time.

o From (&) Internet, tap -~ New tab.

« Toclose atab, tap < Close tab.

Create a Bookmark

Bookmark your favorite webpages to quickly access them.

= From ) Internet, tap  ~ Add to bookmarks to save the open webpage.

Open a Bookmark
Quickly launch a webpage from the Bookmarks page.
1. From &) Internet, tap ¥ = Bookmarks.

2. Tap abookmark entry.

Save a webpage
There are several options to save a webpage in the Samsung Internet app.
- From (&) Internet, tap — Tools > Add page to for the following options:
* Bookmarks: Add the webpage to your Bookmark list.
* Quick access: View a list of commonly accessed or saved webpages.

* Home screen: Create a shortcut to the webpage on your Home screen.

* Saved pages: Save the webpage content on your device so that you can
access it offline.

View history
To view a list of recently visited webpages:

- From () Internet, tap — Tools > History.

TIP To clear your browsing history, tap ¢ More options > Clear history.
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Share pages

Webpages can be shared with your contacts.

- From (&) Internet, tap — Tools > Share, and follow the prompts.

Secret mode

Pages viewed in Secret mode are not listed in your browser history or search history,
and leave no traces (such as cookies) on your device. Secret tabs are a darker shade
than the normal tab windows.

Any downloaded files remain on your device after you close the Secret tab.

1. From (& Internet, tap Tabs > Turn on Secret mode.

2. Tap Start to begin browsing in Secret mode.

Secret mode settings

Require a password or biometric lock to use Secret mode.

1. From &) Internet, tap Tabs.
2. Tap : More options > Secret mode settings for the following options:

* Use password: Create a password to enable Secret mode and use
biometrics.

* Reset Secret mode: Erase your Secret mode data and restore defaults.

Turn off Secret mode

Disable Secret mode and return to normal browsing.

o+ From () Internet, tap Tabs > Turn off Secret mode.

Internet settings

Modify settings associated with using the Internet app.

o From (&) Internet, tap — Tools > Settings.
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My Files

View and manage files stored on your device, including images, videos, music, and
sound clips. You can also access and manage files saved to your cloud accounts and
SD card, if supported.

My Files Q
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File groups

Files stored in the device are organized into the following groups:

- Recent files: View recently accessed files.

- Categories: View your files based on the file type.

- Storage: View files saved on your device, optional SD card, and cloud accounts.
- Cloud accounts vary depending on the services you signin to.

- Trash: Choose to restore or permanently remove files that you delete.

- Analyze storage: See what's taking up space in your storage.

My Files settings
Use My Files settings to customize your file management options and more. Options
mMay vary by service provider.
o From(__ My Files, tap : More options > Settings for the following options:
* Cloud accounts: Connect to and manage your cloud services.

* File management: Customize how files are displayed, deleted, and access
mobile data.

* Analyze storage: Choose a file size to flag when analyzing storage.

* Privacy: View the permissions for My Files.
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O Samsung Notes

Use Samsung Notes to create notes containing text, images with footnotes, voice

recordings, and music. You can share your notes easily using social networking

services.

Visit samsung.com/us/support/owners/app/samsung-notes to learn more.
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Create notes
Add text,images, voice recordings and more.

1. From ) Samsung Notes, tap  Add.

2. Use the text OptiOhS to create content.

Voice recordings

Create annotated voice recordings perfect for lectures or meetings. Take notes while
recording audio. Playback is synced to scroll to the corresponding text.

1. From ) Samsung Notes, tap “ Add.
2. Tap// Insert > Voice recording.

3. Use the text options to create content while audio is being recorded.

Edit notes
Make edits to notes you create.

1. From ) Samsung Notes, tap a note to view it.
2. Tap[& Edit and make changes.
3. When you are finished, tap < Navigate up.

Notes options

You can edit, sort, or manage notes.

o From O Samsung Notes, the following options are available:
« | Import PDF: Open a PDF in Samsung Notes.
. Search: Search for a keyword.
+ ¢ More options:
- Edit: Select notes to share, delete, save as file, lock, or move.
- View: Switch between Grid, List, or Simple list.

- Pin favorites to top: Keep notes marked as your favorites at the top of the
main page.
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Notes menu

You can view your notes by category.

o From O Samsung Notes, tap — Show havigation menu for the following options:
. Settings: View settings for the Samsung Notes app.
* Allnotes: View all notes.

* Shared notes: View notes shared with your contacts through your Samsung
account.

* Trash: View deleted notes for up to 15 days.
* Folders: View notes by groups.

* Manage folders: Add, remove, and organize folders.
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Google apps

The following Google apps may be preloaded on your device. Apps can be
downloaded from the Google Play” store.

@ Chrome

Browse the Internet with Chrome™ and bring your open tabs, bookmarks, and address
bar data from your computer to your mobile device.

Visit support.google.com/chrome to learn more.

@ Drive

Open, view, rename, and share files saved to your Google Drive” cloud account.

Visit support.google.com/drive to learn more.

@ Gmail

Send and receive email with Google’'s web-based email service.

Visit support.google.com/mail to learn more.

G Google

Find online content with tools that learn what interests you. Turn on your personalized
feed to receive customized content.

Visit support.google.com/websearch to learn more.
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) Google TV

Watch movies and TV shows purchased from Google Play. You can also view videos
saved on your device.

Visit support.google.com/googletv to learn more.

Q Maps
Get directions and other location-based information. You must enable location

services to use Google Maps. For more information, see

Visit support.google.com/maps to learn more.

i Meet
Make cross-platform video calls on phones and tablets, smart devices, and on the
web.

Visit support.google.com/meet to learn more.

\ ‘.v Photos
Store and back up your photos and videos automatically to your Google Account with

Google Photos”.

Visit support.google.com/photos to learn more.

B Play Store

Find new apps, movies and TV shows, music, books, magazines, and games in the
Google Play store.

Visit support.google.com/play to learn more.
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@ YouTube

Watch and upload YouTube" videos right from your device.

Visit support.google.com/youtube to learn more.

© v Music

Stream and browse playlists, albums, and artists from YouTube Music.
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Microsoft apps

The following Microsoft apps may be preloaded on your device. Apps can be

downloaded from Galaxy Store and the Google Play store.

::;\ Outlook

Access email, calendar, contacts, tasks, and more in Outlook. See
. Visit support.office.com/en-us/article/outlook-for-ios-and-android-help-

cd84214e-a5ac-4e95-9ea3-e07f78d0cdeé to learn more.

Show

To John

Hi John

| hope you are doing well. Please call me later today.

Thanks!

formatting
options

Add

attachments

Devices and software are constantly evolving — the illustrations you see here are for reference only.

v
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8 Microsoft 365

Enjoy the Word, Excel, and PowerPoint apps on your mobile device with the Microsoft
365 app.

&  OnebDrive

NS

Store and share photos, videos, documents, and more in your free online OneDrive®
account—accessible from your personal computer, tablet, or phone.
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Access Settings

There are a couple of ways to access your device settings.

« From a Home screen, swipe down and tap &£ I Settings.

« From Apps, tap @ Settings.

Search for Settings

If you are not sure exactly where to find a certain setting, you can search for it.

1. From Settings, tap(_) Search, and enter keywords.

2. Tap an entry to go to that setting.

Connections

Manage connections between your device and a variety of networks and other
devices.

Wi-Fi
You can connect your device to a Wi-Fi network to access the Internet without using
your mobile data.
1. From Settings, tap (& Connections > Wi-Fi, and then tap to turn on Wi-Fi and
scan for available networks.
2. Tap anetwork, and enter a password if required.

3. Tap Connect.
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Connect to a hidden Wi-Fi network

If the Wi-Fi network you want is not listed after a scan, you can still connect to it by
entering the information manually. Ask the Wi-Fi network administrator for the name
and password before you begin.

1. From Settings, tap (& Connections > Wi-Fi, and then tap to turn on Wi-Fi.
2. Tap=f= Add network at the bottom of the list.
3. Enter information about the Wi-Fi network:

* Network name: Type the exact name of the network.

* Security: Select a security option from the list, and enter the password if
required.

* Password: Enter the network password.

* Hidden network: Add a hidden network.

* View more: Define other advanced options, such as IP and Proxy settings.
4. Tap Save.

TIP Top:E-a‘fs‘: Scan QR code to connect to a Wi-Fi network by using your device's
camera to scan a QR code.

Wi-Fi Direct

Wi-Fi Direct uses Wi-Fi to share data between devices.
1. From Settings, tap (&) Connections > Wi-Fi, and then tap to turn on Wi-Fi.
2. Tap ¢ More options > Wi-FiDirect.

3. Tap adevice, and then follow the prompts to connect.

Disconnect from Wi-Fi Direct

Disconnect your device from a Wi-Fi Direct device.

o+ From Settings, tap (&) Connections > Wi-Fi > ¢ More options > Wi-Fi Direct. Tap a
device to disconnect it.
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Intelligent Wi-Fi settings
You can configure connections to various types of Wi-Fi networks and hotspots,
mManage saved networks and look up your device's network addresses. Options may
vary by service provider.

1. From Settings, tap (&) Connections > Wi-Fi, and then tap to turn on Wi-Fi.

2. Tap : More options > Intelligent Wi-Fi for the following options:

* Switch to mobile data: When enabled, your device will switch to mobile data
whenever the Wi-Fi connection is unstable. When the Wi-Fi signal is strong, it
switches back to Wi-Fi.

* Turn Wi-Fi on/off automatically: Turn on Wi-Fi in frequently-used locations.

* Auto Hotspot connection: Automatically connect to a Wi-Fi hotspot when
detected.

* Intelligent Wi-Fi: View the Intelligent Wi-Fi version.

Advanced Wi-Fi settings
You can configure connections to various types of Wi-Fi networks and hotspots,
manage saved networks and look up your device's network addresses. Options may
vary by service provider.

1. From Settings, tap (&) Connections > Wi-Fi, and then tap to turn on Wi-Fi.

2. Tap : More options > Advanced settings for the following options:

* Sync with Samsung Cloud/account: Sync Wi-Fi profiles with your Samsung
account.

* Show Wi-Fi pop-up: Alert me that Wi-Fiis available when opening apps.

- Network notification /Wi-Fi notifications: Receive notifications when open
networks in range are detected.

* Manage networks: View saved Wi-Fi networks and configure whether to auto
reconnect to or forget individual networks.

* Wi-Fi on/off history: View apps that have recently turned your Wi-Fi on or off.

* Hotspot 2.0: Connect automatically to Wi-Fi networks that support
Hotspot 2.0.

* Install network certificates: Install authentication certificates.
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Bluetooth

You can pair your device to other Bluetooth-enabled devices, like Bluetooth
headphones or a Bluetooth-enabled vehicle infotainment system. Once a pairing is
created, the devices remember each other and can exchange information without
having to enter the passkey again.

1. From Settings, tap (& Connections > Bluetooth, and then tap to turnon
Bluetooth.
2. Tap a device and follow the prompts to connect.
* To disconnect from a paired device, tap Disconnect. Tap Connect to
reconnect.

_‘Q’_ TIP When sharing a file, tap (21 Bluetooth to use this feature.

/ N\

Rename a paired device
You can rename a paired device to make it easier to recognize.

1. From Settings, tap (& Connections > Bluetooth, and then tap to turnon
Bluetooth.
2. Tap:os Settings next to the device name, and then tap Rename.

3. Enter anew name, and tap Rename.

Unpair from a Bluetooth device

When you unpair from a Bluetooth device, the two devices no longer recognize each
other and you will need to pair with the device again in order to connect to it.

1. From Settings, tap (& Connections > Bluetooth, and then tap to turnon
Bluetooth.
2. Tap¢o; Settings next to the device, and then tap Unpair.

3. Tap Unpair to confirm.
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Advanced Bluetooth settings

Additional Bluetooth features are available in the Advanced menu. Options may vary
by service provider.

1.
2.

From Settings, tap (& Connections > Bluetooth.

Tap Advanced settings or : More options > Advanced settings for the following

options:

» Sync with Samsung Cloud/account: Sync files transferred through Bluetooth
with your Samsung account.

» Tablet name: Change the name of your device for Bluetooth connections.

 Received files: View allist of files received using Bluetooth.

* Bluetooth control history: View apps that have used Bluetooth recently.

* Block pairing requests: Add devices to block pairing requests.

* Bluetooth scan history: View which apps have recently scanned for nearby
Bluetooth devices and manage Bluetooth features for apps.

Airplane mode

Airplane mode turns off all network connections including calling, texting, mobile data,
Wi-Fi, and Bluetooth. While Airplane mode is enabled, you can turn on Wi-Fi and
Bluetooth in Settings or from the Quick settings panel.

7 From Settings, tap (G Connections > Airplane mode, and then tap to enable

this feature.

NOTE The use of mobile devices on an aircraft or a ship may be subject to federal
and local guidelines and restrictions. Airplane mode will disable all network
connectivity. Ultra-wideband (UWB) is not permitted aboard aircraft or ships and
can be turned off by use of Airplane mode. Check with appropriate authorities
and always follow crew instructions regarding when and how you may use your
device.
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Mobile networks

Use Mobile networks to configure your device's ability to connect to mobile networks
and use mobile data. Options may vary by service provider.

o+ From Settings, tap (G Connections > Mobile networks.

Mobile data: Enable mobile data usage.

International data roaming: Change voice, text and data roaming settings for
international roaming.

Data roaming: Choose whether to allow your device to connect to mobile
data while traveling outside your service provider's network area.

Data roaming access: Configure access to mobile networks while roaming.

Roaming state: Enable or disable data while roaming on other mobile
networks.

Signal strength: View mobile signal strength.

Access Point Names: Choose or add APNs, which have the network settings
your device needs to connect to your provider.

Network operators: Choose available and preferred networks.

Network extenders: Scan for cells that can extend your network connection.

_‘Q’_ TIP Use these features to help manage connection settings that may affect your
monthly bill.

Data usage

Check your current mobile and Wi-Fi data usage. You can also customize warnings
and limits.

o From Settings, tap (& Connections > Data usage.
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Turn on Data saver
Use Data saver to reduce your data consumption by preventing selected apps from
sending or receiving data in the background.

1. From Settings, tap (& Connections > Data usage > Data saver.

2. Tap to turn on Data saver.

* To allow some apps to have unrestricted data usage, tap Allowed to use data
while Data saver is on, and tap next to each app to specify restrictions.

Monitor mobile data
You can customize your mobile data access by setting limits and restrictions. Options

mMay vary by service provider.

¢+ From Settings, tap (G Connections > Data usage. The following options are
available:

* Mobile data: Use mobile data from your plan.

* International data roaming: Enable mobile data services while roaming
internationally.

* Mobile data only apps: Set apps to always use mobile data, even when your
device is connected to Wi-Fi.

* Mobile data usage: View data usage over mobile connections over a period
of time. You can view total usage as well as usage by app.

* Billing cycle and data warning: Change the monthly date to align with your
service provider's billing date.

TIP Use these features to keep an eye on your estimated data usage.

Monitor Wi-Fi data

You can restrict Wi-Fi data access by customizing usage limits and networks.

1. From Settings, tap (&) Connections > Data usage.

2. Tap Wi-Fi data usage to view data usage over Wi-Fi connections over a period of
time. You can view total usage as well as usage by app.
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Mobile hotspot
Mobile hotspot uses your data plan to create a Wi-Fi network that can be used by
multiple devices.
1. From Settings, tap (& Connections > Mobile hotspot and tethering >
Mobile hotspot.
2. Tap to turn on Mobile hotspot.

3. On the devices you want to connect, activate Wi-Fi and select your device’'s
Mobile hotspot. Enter the Mobile hotspot password to connect.

* Connected devices are listed under the heading Connected devices.

/Y- TIP Tap’ i QR code to connect another device to your Mobile hotspot by
= scanning a QR code instead of entering a password.

Configure mobile hotspot settings
You can customize your mobile hotspot's security and connection settings.
1. From Settings, tap [ Connections > Mobile hotspot and tethering >
Mobile hotspot.
2. Tap Configure for the following settings:
* Network name: View and change the name of your Mobile hotspot.

* Password: If you choose a security level that uses a password, you can view
or changeiit.

* Band: Select one of the available bandwidth options.
* Security: Choose the security level for your Mobile hotspot.

* Advanced: Configure additional Mobile hotspot settings.

Auto hotspot

Share your hotspot connection automatically with other devices signed in to your
Samsung account.

1. From Settings, tap (&) Connections > Mobile hotspot and tethering > Mobile
hotspot.

2. Tap Auto hotspot, and tap to enable the feature.
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Tethering
You can use tethering to share your device's Internet connection with another device.
Options may vary by service provider.

1. From Settings, tap [ Connections > Mobile hotspot and tethering.

2. Tap an option:

* Tap Bluetooth tethering to share your device's Internet connection using
Bluetooth.

* Connect the computer to the device using a USB cable, and then tap
USB tethering.

* Connect the computer to the device using an Ethernet adapter, and
then tap Ethernet tethering.

Nearby device scanning

Easily set up connections to other available devices by turning on Nearby device
scanning. This feature sends you a notification when there are available devices to
connect to.

1. From Settings, tap (& Connections > More connection settings > Nearby device
scanning.

2. Tap to turn on the feature.

Connect to a printer

Connect your device to a printer on the same Wi-Fi network to easily print documents
and images from your device.

1. From Settings, tap (& Connections > More connection settings > Printing.
2. Tap Default print service, and then tap : More options > Add printer.

- If your printer requires a plugin, top+ Download plugin and follow the
prompts to add a print service.

NOTE Not all apps support printing.
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Virtual Private Networks

A Virtual Private Network (VPN) allows you to connect to a private secured network
from your device. You will need the connection information from your VPN
administrator.

1. From Settings, tap (&) Connections > More connection settings > VPN.
2. Tap : More options > Add VPN profile.

3. Enter the VPN network information provided by your network administrator, and
tap Save.

Manage a VPN

Use the VPN settings menu to edit or delete a VPN connection.

1. From Settings, tap (&) Connections > More connection settings > VPN.
2. Tap¢o; Settings next to a VPN.
3. Edit the VPN and tap Save, or tap Delete to remove the VPN.

Connectto a VPN

Once you have set up a VPN, connecting to and disconnecting from a VPN is easy.

1. From Settings, tap (| Connections > More connection settings > VPN.
2. Tap a VPN, enter your log in information, and tap Connect.

» To disconnect, tap the VPN, and then tap Disconnect.

Private DNS

You can configure your device to connect to a private DNS host.

1. From Settings, tap (&) Connections > More connection settings > Private DNS.
2. Tap one of the available options to configure a private DNS connection.

3. Tap Save.
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Ethernet

If wireless network connection is not available, you can use an Ethernet cable to
connect your device to alocal network.
1. Connect an Ethernet cable to your device.

2. From Settings, tap (&) Connections > More connection settings > Ethernet, and
follow the prompts.

(Y- TIP You need an adapter (not included) to connect an Ethernet cable to your

=N

device.

Network unlock

View your device's network lock status and check if your device is eligible to be
unlocked for use on another mobile network. Options may vary by service provider.

o From Settings, tap (& Connections > More connection settings > Network unlock
for the following options:
* Network lock status: View the current status of your device's network lock.

* Permanent unlock: Request a permanent network unlock so you can use
your device with other service providers.

* Temporary unlock: Request a temporary network unlock so you can use your
device with other service providers.

Connected devices

Achieve mobile continuity between your device and other connected devices.
Options may vary by service provider.
o+ From Settings, tap (..} Connected devices for the following features:

* Quick Share: Allow anyone with a Samsung account to share files with your
device.

* Auto switch Buds: Automatically switch your Galaxy Buds from another
device to this device when you make a call, answer a call, or play media.
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* Continue apps on other devices: Pick up where you left off on your Galaxy
devices that are signed in to your Samsung account.

* SmartThings: Use your device to connect to an ecosystem of smarter living
solutions.

Sounds and vibration

You can control the sounds and vibrations used to indicate notifications, screen
touches, and other interactions.

Sound mode

You can change the sound mode on your device without using the volume keys.

-+ From Settings, tap (1) Sounds and vibration, and then choose a mode:

* Sound: Use the sounds, vibrations, and volume levels you have chosenin
Sound settings for notifications and alerts.

* Vibrate: Use vibration only for notifications and alerts.
* Mute: Set your device to make no sounds.

- Temporary mute: Set a time limit for muting the device.

_‘Q’_ TIP Use the sound mode setting instead of the volume keys to change the sound
mode without losing your customized sound levels.
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Vibrations

You can control how and when your device vibrates.

1. From Settings, tap () Sounds and vibration.
2. Tap options to customize:
* Notification vibration: Choose from preset vibration patterns for notifications.
* System vibration: Configure vibration intensity and feedback for the following
options:
— System vibration intensity: Drag the slider to adjust vibration intensity.

Touch interactions: Vibrate when you tap navigation buttons or touch
and hold items on the screen.

— Samsung keyboard: Vibrate when typing with the Samsung
keyboard.

Charging: Vibrate when a charger is connected.

Navigation gestures: Vibrate when using gestures.

* Vibration intensity: Set vibration intensity levels for notifications and touch
interactions by dragging the sliders.

Volume

Set the volume level for notifications, media, and system sounds.

- From Settings, tap () Sounds and vibration > Volume, and drag the sliders for
each sound type.

(Y- TIP You can also use the Volume keys to adjust the volume. When pressed, a

= pop-up menu shows the volume level and current sound type. You can tap the
menu to expand it, and then adjust the volume of the other sound types by
dragging their sliders.
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Use Volume keys for media

Set the default action of the Volume keys to control the media sound volume rather
than whichever sound type isin use.

1. From Settings, tap (L2} Sounds and vibration > Volume.

2. Tap Use Volume keys for media to enable this feature.

Media volume limit

Limit the maximum output of the device's volume while using Bluetooth speakers or
headphones (not included).

1. From Settings, tap (L) Sounds and vibration > Volume.
2. Tap : More options > Media volume limit.
3. Tap to enable this feature.

+ To set the maximum output volume, drag the Custom volume limit slider.

« Torequire aPIN to make changes to the volume setting, tap Set volume
limit PIN.

Notification sound

Choose a preset sound for all notification alerts.

1. From Settings, tap () Sounds and vibration > Notification sound.
2. Drag the slider to adjust the notification sound volume.

3. Tap asound to hear a preview and select it.

‘Q’ TIP You can also customize notifications sounds to be unique for each app using
the App settings menu.
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System sound

Customize your device's sounds for actions like tapping the screen and charging the
device. Options may vary by service provider.

2 From Settings, tap ({2} Sounds and vibration > System sound for the following
options:
* System sound volume: Drag the slider to adjust the system volume.

* Touch interactions: Play tones when you touch or tap the screen to make
selections.

* Samsung keyboard: Play a sound when typing with the Samsung keyboard.
* Charging: Play a sound when a charger is connected.

* Screen lock/unlock: Play a sound when you lock or unlock the screen.

Dolby Atmos

Enjoy Dolby Atmos quality when playing content that was specifically mixed for
Atmos. This feature may only be available with a headset connected.

 From Settings, tap £2) Sounds and vibration > Sound quality and effects for the
following options:

* Dolby Atmos: Experience breakthrough audio that flows above and
around you.

* Dolby Atmos for gaming: Apply Dolby Atmos optimized for gaming.

Separate app sound

You can choose to have an app play only media sound on a Bluetooth speaker or
headset separate from the other sounds (like notifications). Connect to a Bluetooth
device to make this option available in the Audio device menu.

1. From Settings, tap £)) Sounds and vibration > Separate app sound.

2. Tap Turn on now to enable Separate app sound, and then set the following
options:

* App: Choose an app to play its sound on a separate audio device.

* Audio device: Choose the audio device that you want the app'’s sound to be
played on.
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Notifications

You can prioritize and streamline app alerts by changing which apps send
notifications and how notifications alert you.

App notifications

Choose which apps are allowed to send you notifications.

-+ From Settings, tap(_J Notifications > App notifications, and then tap to enable
notifications for individual apps.

Lock screen notifications

Choose which notifications are allowed on the Lock screen.

: From Settings, tap (7 Notifications > Lock screen notifications, and then tap to
enable the feature. Tap an option to customize:

* Hide content: Do not show notifications in the Notification panel.

* Notifications to show: Choose which notifications to show on the Lock screen.

Notification pop-up style
You can change the style and additional settings for your notifications.

+ From Settings, tap(_J Notifications > Notification pop-up style, and then choose a
pop-up style:
* Brief: Enable customization of your notifications.
- Apps to show as brief: Choose apps to show as brief notifications.
- Edge lighting style: Choose a style of edge lighting for notifications.

- Color by keyword: Choose custom colors for notifications containing
keywords that matter to you.

* Detdiled: Enable the default Samsung Notification settings.
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Do not disturb

Do not disturb allows you to block sounds and notifications while this mode in turned
on. You can also specify exceptions for people, apps, and alarms. You can also set a
schedule for recurring events like sleep or meetings.
-+ From Settings, tap (7 Notifications > Do not disturb and configure the following:
* Do not disturb: Enable Do not disturb to block sounds and notifications.

* For how long?: Choose a default duration for Do not disturb mode when you
enable it manually.

Schedule
* Sleeping: Customize a schedule for Do not disturlb mode while you are
sleeping.

* Add schedule: Create a new schedule to configure the days and times to
regularly put your device in Do not disturib mode.

Allowed during Do not disturb

* Calls and messages: Tap to allow Do not disturb exceptions.

* App notifications: Add apps that you would like to receive notifications fromin
Do not disturb mode. Call, message, and conversation notifications will still
reach you evenif you don't allow the associated apps.

* Alarms and sounds: Enable sounds and vibrations for alarms, events, and
reminders while Do not disturb mode is active.

* Hide notifications: View customization options to hide notifications.

Advanced notifications settings

You can configure notifications from apps and services.

: From Settings, tap [/ Notifications > Advanced settings.

* Show natification icons: Modify how many notifications appear on the
Status bar.

* Show date: Display the date on the Status bar.

* Show battery percentage: Display the current battery life of your device on
the Status bar.
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* Notification history: Display recent and snoozed notifications.

* Conversations: View conversation notifications. Touch and hold a
conversation notification to mark it as priority, set it as alerting, or silent.

* Floating notifications: Enable floating notifications in either Bubbles or Smart
pop-up view.

* Suggest actions and replies for notifications: Get applicable suggestions for
actions to notifications and replies to messages.

* Show snooze button: Enable to display a button to quickly snooze your
notifications.

* Notification reminders: Enable and customize periodic reminders about
notifications from selected apps and services. Clear notifications to stop the
reminders.

* App icon badges: Identify which apps have active notifications with badges
that appear on their icons. Tap to choose whether or not badges indicate the
number of unread notifications.
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Display

You can configure the screen brightness, timeout delay, font size, and many other
display settings.

Dark mode

Dark mode allows you to switch to a darker theme to keep your eyes more
comfortable at night, darkening white or bright screens and notifications.
¢+ From Settings, tap . Display for the following options:
« Light: Apply a light color theme to your device (default).
» Dark: Apply a dark color theme to your device.
« Dark mode settings: Customize when and where Dark mode is applied.

- Turn on as scheduled: Configure Dark mode for either Sunset to sunrise or
Custom schedule.

Screen brightness

Adjust the screen brightness according to lighting conditions or personal preference.

1. From Settings, tap .= Display.
2. Customize options under Brightness:
* Drag the Brightness slider to set a custom brightness level.
* Tap Adaptive brightness to automatically adjust the screen brightness based

on the lighting conditions.

_‘Q’_ TIP You can also adjust screen brightness from the Quick settings panel.

/ \
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Eye comfort shield
This feature may help you sleep better and reduce eye strain. You can set a schedule
to automatically turn this feature on and off.
1. From Settings, tap .+ Display > Eye comfort shield, and then tap to enable
this feature.
2. Tap an option to customize:
* Set schedule and choose Always on, Sunset to sunrise, or Custom.

* Drag the Color temperature slider to set the opacity of the filter.

Font size and style

You can change the font size and style to customize your device.

: From Settings, tap .~ Display > Font size and style for the following options:

* Tap Font style to choose a different font.

- Tap afonttoselectit, or tcp+ Download fonts to add fonts from
Galaxy Store.

* Tap Bold font to make all fonts appear with bold weight.

* Drag the Font size slider to adjust the size of text.

Screen zoom

Adjust the zoom level to make content easier to see.

1. From Settings, tap .+ Display > Screen zoom.

2. Drag the Screen zoom slider to adjust the zoom level.
Screen timeout

You can set the screen to turn off after a set amount of time.

- From Settings, tap [+ Display > Screen timeout, and tap a time limit to set it.

NOTE Prolonged display of non-moving images, excluding Always On Display,
may result in permanent ghost-like afterimages or degraded image quality. Turn
off the display screen when notin use.
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Screen saver

You can display colors or photos when the screen turns off or while charging.

1. From Settings, tap .+ Display > Screen saver.
2. Choose one of the following options:
* None: Do not display a screen saver.

* Colors: Tap the selector to display a changing screen of colors.

Photo table: Display pictures in a photo table.
* Photo frame: Display pictures in a photo frame.
* Photos: Display pictures from your Google Photos account.

3. Tap Preview for a demonstration of the selected Screen saver.

_‘Q’. TIP Tap:os Settings next to a feature for additional options.

Double tap to turn on screen

Turn on the screen by double-tapping instead of using the Side key.

+ From Settings, tap |~ Advanced features > Motions and gestures > Double tap
to turn on screen to enable this feature.

Double tap to turn off screen
Turn off the screen by double-tapping instead of using the Side key.

: From Settings, tap | '~ Advanced features > Motions and gestures > Double tap
to turn off screen to enable this feature.

100



Settings

Lock screen and security

You can secure your device and protect your data by setting a screen lock.

Screenlock types

You can choose from the following screen lock types that offer high, medium, or no
security: Swipe, Pattern, PIN, Password, and None.

NOTE Biometric locks are also available to protect access to your device and
sensitive data on your device. For more information, see

Set asecure screen lock
It is recommended that you secure your device using a secure screen lock (Pattern,
PIN, or Password). This is necessary to set up and enable biometric locks.
1. From Settings, tap 0 Lock screen > Screen lock type and tap a secure screen
lock (Pattern, PIN, or Password).

2. Tap to enable showing notifications on the lock screen. The following
options are available:

* Hide content: Do not show notifications in the Notification panel.

* Notifications to show: Choose which notifications to show on the Lock screen.
3. Tap Done to exit the menu.
4. Configure the following screen lock options:

* Smart Lock: Unlock your device automatically when trusted locations or
other devices have been detected. A secure screen lock is required for this
feature.

* Secure lock settings: Customize your secure lock settings. A secure screen
lock is required for this feature.
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* Lock screen: Tap to edit the items on and appearance of the Lock screen.

* Widgets: Tap to edit the widgets that appear with the clock on the Lock
screen.

* Touch and hold to edit: Choose whether to allow items on the Lock screen to
be edited by touching and holding them.

* Roaming clock: Show the time both where you are and at home while you
are roaming.

* About Lock screen: Update the Lock screen'’s software.

Find My Mobile

You can protect your device from loss or theft by allowing your device to be locked,
tracked online, and for your data to be deleted remotely. A Samsung account is
required, and Google location service must be turned on in order to use Find My
Mobile. For more information, visit samsung.com/us/support/owners/app/find-my-
nmobile.

Turn on Find My Mobile
Before you can use the Find My Mobile feature, you must turn it on and customize
the options. To access your device remotely, visit findmymobile.samsung.com.

1. From Settings, tap ((J) Security and privacy > Find My Mobile.
2. Tap to enable Find My Mobile and log in to your Samsung account. The
following options are available:
* Allow this tablet to be found: Enable to permit this feature to find this device.

* Remote unlock: Allow Samsung to store your PIN, pattern, or password,
allowing you to unlock and control your device remotely.

* Send last location: Allow your device to send its last location to the Find My
Mobile server when the remaining battery charge falls below a certain level.
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Google PIC]y Protect
You can configure Google Play to regularly check your apps and device for security
risks and threats.

o From Settings, tap o Security and privacy > App security > Google Play Protect.

* Updates are checked for automatically.

Security update
You can easily check the date of the last installed security software update and find

out if newer updates are available.

o+ From Settings, tap o Security and privacy > Updates > Security update to see the
latest security update installed and check if a newer update is available.

Permission manager

Apps might access features of your device that you permit them to (like the camera,
microphone, or location) when they are running in the background, not just when you
are using the app. You can set your device to notify you when this happens.

1. From Settings, tap 0 Security and privacy > Privacy > Permission manager.
2. Tap acategory, then tap an app to select which permissions you want to be
notified about.

NOTE When using an app or service for the first time that wants to access certain
features of your device, a dialog box asks if you want to permit such access.

Controls and adlerts

Control app access to the camera, microphone, and clipboard..

1. From Settings, tap ((J) Security and privacy > Privacy.
2. Under Controls and alerts tap the following options to enable or disable:

* Microphone access: Allow apps to use the microphone if they have the
appropriate permissions.

* Alert when clipboard accessed: Get an alert when an app accesses content
copied to the clipboard.
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Samsung Privacy

Send diagnostic information about your device to Samsung when you are having
technical problems.

1. From Settings, tap ((J) Security and privacy > Privacy > Other privacy settings.
2. Under Samsung tap the following options to customize:
* Samsung Privacy: View Samsung's privacy information.

* Send diagnostic data: Send diagnostic information about your device to
Samsung when you are having technical problems.

Google Privacy

Customize Android and Google privacy features.

1. From Settings, tap 0 Security and privacy > Privacy > Other privacy settings.

2. Under Google tap privacy services to customize them.

Private Share

Share files privately, prevent recipients from resharing, and set expiration dates. Keep
your data safe with blockchain technology.

¢ From Settings, tap ((J) Security and privacy > Private share, and follow the
prompts to add files.

Install unknown apps

You can allow installation of unknown third-party apps from selected apps or
sources.

1. From Settings, tap (J) Security and privacy > Install unknown apps.

2. Tap to allow installation from an app or source.

_‘q'?’_ TIP Installing unknown third-party apps could make your device and personal
data more vulnerable to security risks.
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Encrypt SD card
You can encrypt your optional microSD card (not included) to protect its data. This

only allows the card information to be accessed from your device with a password.

1. From Settings, tap o Security and privacy > Other security settings > Encrypt SD
card.

2. Tap Encrypt SD card and follow the prompts to encrypt all data on your microSb
card.

NOTE Performing a Factory data reset on your device prevents it from accessing
an encrypted microSD card. Before initiating a Factory data reset, make sure to
decrypt the installed microSD card first.

Password for factory data reset

You can require a password to reset your device to factory default settings. Options
mMay vary by service provider.

o From Settings, tap o Security and privacy > Other security settings >
Set up/change password and enter a password.

Setup SIM card lock

You can set up aPIN to lock your SIM card, which prevents unauthorized use of your
SIM card if someone attempts to use itin another device. Options may vary by service
provider.

o+ From Settings, tap o Security and privacy > Other security settings > Set up SIM
card lock and follow the prompts.
* Tap Lock SIM card to turn on the feature.

* Tap Change SIM card PIN to create a new PIN.

View passwords

You can have characters displayed briefly in password fields as you type them.

o+ From Settings, tap o Security and privacy > Other security settings > Make
passwords visible to turn on the feature.
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Device administration

You can authorize security features and apps to have administrative access to your
device.

1. From Settings, tap ((J) Security and privacy > Other security settings > Device
admin apps.

2. Tap an option to turn it on as a device administrator.

Credential storage

You can manage the trusted security certificates installed on your device, which
verify the identity of servers for secure connections.

¢+ From Settings, tap o Security and privacy > Other security settings for the
following options:
* View security certificates: Display the certificates on your device.
* User certificates: View user certificates that identify your device.
- Install from device/phone storage: Install a new certificate from storage.

* Clear credentials: Erase credential contents from the device and reset the
password.

* Certificate management app: Select a certification management app for
credential contents.

Advanced security settings

You can use these options to configure advanced security settings to better protect
your device.

o+ From Settings, tap o Security and privacy > Other security settings for the
following options:

* Trust agents: Allow trusted devices to perform selected actions when
connected.

- This optionis only displayed when a lock screen is turned on. For more
information, see
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* Pin app: Pin an app on your device screen, which prevents access to other
features of your device.

* Galaxy system app update: Configure your device to receive and install
Samsung updates automatically.

* Security policy updates: Keep your device secure by checking for security
updates.

Location

Location services use a combination of GPS, mobile network and Wi-Fi to determine
the location of your device.

1. From Settings, tap(.:/ Location.

2. Tap to turn on Location services.

.‘Q’. TIP Some apps require location services be turned on to function.

App permissions
Configure permissions for apps that want to access your location information.

1. From Settings, tap(.:/ Location > App permissions.

2. Tap an app and chose which location permissions to grant it. Options vary by
app.

Location services
Location services store and use your device's most recent location data. Certain apps
can use this data to improve your search results based on places that you have
visited.

1. From Settings, tap(.*/| Location.

2. Tap an entry under Location services to see how your location information is
used.
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IMmprove accuracy
Enable other location scanning tools.
1. From Settings, tap(.*/| Location > Location services.

2. Tap a connection method under Improve accuracy to add or remove from
location services:

* Wi-Fi scanning: Allow apps and services to scan for Wi-Fi networks
automatically, even when Wi-Fi is turned off.

* Bluetooth scanning: Allow apps to scan for and connect to nearby devices
automatically through Bluetooth, even when Bluetooth is turned off.

Recent access

View allist of apps that have requested your location.
1. From Settings, tap(.:/ Location.
2. Tap to turn on Location services.

3. Tap an entry under Recent access to view the app’s settings.

Emergency Location Service

If Emergency Location Service (ELS) is supported in your region, when you call or text
an emergency number, your device can automatically send its location to
emergency response partners.

1. From Settings, tap ('1 Safety and emergency > Emergency Location Service.

2. Tap to turn on Emergency Location Service.
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Accounts

You can connect to and manage your accounts, including your Google Account,
Samsung account, email, and social networking accounts.

Add an account

You can add and sync all your email, social networking, and picture and video sharing
accounts.

1. From Settings, tap (@) Accounts and backup > Manage accounts > <~ Add
account.

2. Tap one of the account types.
3. Follow the prompts to enter your credentials and set up the account.

+ Tap Auto sync data to enable automatic updates to your accounts.

Account settings

Each account has its own custom settings. You can configure common settings for all
accounts of the same type. Account settings and available features vary between
account types.

1. From Settings, tap (#) Accounts and backup > Manage accounts.

2. Tap an account to customize its settings.

Remove an account

You can remove accounts from your device.

1. From Settings, tap {€J Accounts and backup > Manage accounts.

2. Tap the account and then tap Remove account.
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Users

Share this tablet with multiple people by creating User accounts.

Users have their own space, which they can customize with their own apps,
wallpaper, and settings. Users can also adjust tablet settings that affect everyone,
such as Wi-Fi.

1. From Settings, tap () Accounts and backup > Users.
2. Tap=}= Add user or profile and follow the prompts to set up a new user or profile.

_‘Q’_ TIP Restricted profiles allow only limited access to apps and content.

Switch User Profiles
To access the device with a different user profile:

:+ From aLock screen,tap  Manage users and tap a user or profile from the list.

Delete a User or Profile
1. From Settings, tap () Accounts and backup > Users.

2. Tap auser profile.
3. Tap || Delete user, and then confirm when prompted.

NOTE Only the device owner can delete other users or profiles. Deleting a user's
profile removes the user account from the device entirely. This includes the user’s
Google Account, Samsung account, and any other local accounts associated
with the user.
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Backup and restore

You can configure your device to back up data to your personal accounts.

Samsung account

You can enable backup of your information to your Samsung account. Options may
vary by service provider.

o From Settings, tap (@) Accounts and backup and tap an option under Samsung
Cloud:

* Back up data: Configure your Samsung account to back up your data.

* Restore data: Use your Samsung account to restore your backup data.

Google Account

You can enable backup of your information to your Google Account.

1. From Settings, tap (@) Accounts and backup.
2. Under Google Drive, tap Back up data.

External storage transfer

You can back up your data to an SD card or a USB storage device, or restore backup
data using Smart Switch. For more information, see

- From Settings, tap (@) Accounts and backup > External storage transfer.

Google settings

You can configure your device’'s Google settings. Available options depend on your
Google Account.

2 From Settings, tap @ Google, and select an option to customize.
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Device maintenance

View the status of your device's battery, storage, and memory. You can also
automatically optimize your device's system resources.

Quick optimization
The quick optimization feature improves device performance through the following
actions:
- Identifying apps that use excessive battery power and clearing unneeded items.
- Deleting unnecessary files and closing apps running in the background.

- Scanning for malware.
To use the quick optimization feature:

s From Settings, tap (@) Battery and device care > Optimize now.

Battery

View how battery power is used for your various device activities.

* Power saving: Save battery life by limiting background network usage,
syncing, and location checking. Choose from additional power saving
options to save more power when this mode is enabled.

* Background usage limits: View apps that you don't use often and limit their
battery usage. To disable this feature, tap Put unused apps to sleep.

- Usage since last full charge: View your recent battery usage by time, app,
and service.

* More battery settings: Configure additional battery settings and notifications.

12



Settings

Storage

View your storage capacity and detailed usage by category and file type. You can
also mount, unmount, or format an optional microSD card (not included).
& From Settings, tap (€) Battery and device care > Storage.

* Tap a category to view and manage files.

SD card

Once an optional microSD card (not included) has been installed in your device, the
card s displayed in the Storage setting.

For more information, see

Mount an SD card

When you install an optional microSD card, it is automatically mounted (connected to
the device) and prepared for use. However, should you unmount the card without
removing it from the device, you need to mount it before it can be accessed.

1. From Settings, tap (©) Battery and device care > Storage.
g P Y g

2. Swipe the screen to SD card, and then tap Mount.

Remove an SD card

To prevent damage to information stored on the card, unmount the card before
removing it from the device.

1. From Settings, tap (€) Battery and device care > Storage.
2. Swipe the screen to SD card, and then tap ¢ More options > Unmount.

3. Remove your microSD card from the device.
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Format an SD card
When formatting an SD card, you should back up all files that are stored on the card
because formatting the SD card deletes ALL stored files.

1. From Settings, tap () Battery and device care > Storage.

2. Swipe the screen to SD card, and then tap ¢ More options > Format.

3. Tap Format to confirm.

Memory

Check the amount of available memory. You can close background apps and reduce
the amount of memory you are using to speed up your device.

memory are shown.
* Tap Clean now to free up as much memory as possible.

* Tap View more to view the full list of apps and services using memory.
Tap (.« toinclude or exclude these apps and services.

* Tap Apps nhot used recently to view apps and services that are included in this
group. Tap (L« toinclude or exclude these apps and services.

* Tap Excluded apps to view allist of apps that have been excluded.
Tap —— Add apps to choose apps to exclude from memory usage

checks.

* Tap RAMPlus to select how much internal storage to use as virtual
memory to improve app performance.
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Advanced device care options

Other Device care features are available in the Advanced menu.

o From Settings, tap (&) Battery and device care. The following options are
available:
. Care report: View information about the restart history and charging and
temperature tips.

More options:
- Add to Apps screen: Display the icon for Device care on the Apps screen.
- Contact us: Contact Samsung support through Samsung members.

- About Device care: View version and license information about the Device
care feature.

* Auto optimization: Automatically restart when needed to keep it in the best
condition.

* Software update: Check for software updates.

* Diagnostics: View the status of you touch screen, sensors, charging, and
more.

* Maintenance mode: Turn on Maintenance mode to protect your privacy
while someone else is using your device, such as when itis being repaired.

Language and input

Configure your device's language and input settings.

Change the device language
You can add languages to your list and organize them according to preference. If an
app does not support your default language, then it willmove to the next supported
language in your list.

1. From Settings, tap £ Generalmanagement > Language.

2. Tap=}= Add language, and select a language from the list.

3. Tap Set as default to change the device language.

* To switch to another language on the list, tap the desired language, and then
tap Apply.
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App languages
Choose which language each app uses by default.
1. From Settings, tap £ Generalmanagement > App languages.

2. Tap an app to change the default language.

Text-to-speech
Configure your Text-to-Speech (TTS) options. TTS is used for various accessibility
features, such as Voice Assistant.

o From Settings, tap e General management > Text-to-speech for options:

* Preferred engine: Choose either the Samsung or Google Text-to-speech
engine. Tap ¢ o3 Settings for options.

* Language: Set the default speech language.

* Speechrate: Set the speed at which the text is spoken.

* Pitch: Set the pitch of the speech.

* Play: Tap to play a short demonstration of speech synthesis.

* Reset: Reset the speech rate and pitch.

Change the voice input language

Download language packs to use while offline.

1. From Settings, tap e General management > Voice input.

2. Tap alanguage pack to use with Voice input while offline.
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Keyboard list and default
Change your default keyboard, modify built-in keyboards, and change keyboard
settings.

:: From Settings, tap &) General management > Keyboard list and default for the
following options:

- Default keyboard: Choose a default keyboard for your device's menus and
keyboards.

* Samsung keyboard: Modify settings for the Samsung keyboard.
* Google voice typing: Modify settings for Google Voice input.

* Keyboard button on navigation bar: Enable a button on the Navigation bar to
quickly switch between keyboards.

Physical keyboards
Customize options when you have a physical keyboard connected to your device
(sold separately).

1. From Settings, tap e General management.

2. Tap Physical keyboard, and then choose an option:

* Show on-screen keyboard: Show the on-screen keyboard while a physical
keyboard is also being used.

 Keyboard shortcuts: Show explanations of the keyboard shortcuts on the
screen.

* Change language shortcut: Enable or disable language key shortcuts for your
physical keyboard.
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Mouse and trackpad

Configure pointer speed and button assignments for an optional mouse or trackpad
(notincluded).

= From Settings, tap ) General management > Mouse and trackpad.

Pointer speed: Drag the slider to the right to go faster or to the left to go
slower.

Wheel scrolling speed: Drag the slider to the right to scroll faster or to the left
to scroll slower.

Enhance pointer precision: Enable to make the mouse cursor move faster or
slower depending on how fast you move your mouse.

Pointer size and color: Change the size and color of the mouse pointer.

Primary mouse button: Choose either the Left or Right mouse button to be
your primary button.

Secondary button: Choose the action of your secondary mouse button.
Middle button: Choose the action of your middle mouse button.
Additional button 1: Choose an action for another available mouse button.

Additional button 2: Choose an action for another available mouse button.

Passwords and autofill

Save time entering information using autofill services.

1. From Settings, tap € GeneralManagement.

2. Tap Passwords and autofill to view your selected services.
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Date and time

By default, your device receives date and time information from the wireless network.
Outside of network coverage, you can set the date and time manually.

o+ From Settings, tap &) General management > Date and time. The following
options are available:

+ Automatic date and time: Receive date and time updates from your wireless
network. When Automatic date and time is disabled, the following options
are available:

- Set date: Enter the current date.
- Set time: Enter the current time.
* Automatic time zone: Use the time zone provided by your mobile network.

* Set time zone based on location: Receive time updates based on your
location.

* Use 24-hour format: Set the format for displaying time.

Troubleshooting

You can check for software updates and, if necessary, reset services on your device.

Software update/System updates

Check for and install available software updates for your device. Options may vary by
service provider.

2 From Settings, tap Software update/System updates for the following options:
* Check for updates: Manually check for software updates.
* Check for software updates: Manually check for software updates.
* Continue update: Resume an update that was interrupted.

+ Show software update history: View a list of all software updates on your
device.

* Smart updates: Install security updates automatically.

* Download and install: Check for software updates and install if any are
available.
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* Last update: View information about the installation of the current software.

* Use software upgrade assistant: Install a tool to install system updates.

Reset

Reset device and network settings. You can also reset your device to its factory
defaults.

Reset all settings

You can reset your device to its factory default settings, which resets everything
except the security, language, and account settings. Personal data is not affected.

1. From Settings, tap &) General management > Reset > Reset all settings.

2. Tap Reset settings, and confirm when prompted.

Reset network settings
You can reset Wi-Fi, mobile data, and Bluetooth settings with Reset network settings.
1. From Settings, tap & General management > Reset > Reset network settings.

2. Tap Reset settings, and confirm when prompted.

Reset accessibility settings

You can reset device accessibility settings. Accessibility settings in downloaded apps
and your personal data are not affected.

1. From Settings, tap £ Generalmanagement > Reset > Reset accessibility settings.

2. Tap Reset settings, and confirm when prompted.

Factory Data Reset

You can reset your device to factory defaults, erasing all data from your device.
This action permanently erases ALL data from the device, including Google or other
account settings, system and application data and settings, downloaded

applications, as well as your music, photos, videos, and other files. Any data stored on
an external SD card is not affected.

If you signin to a Google Account on your device and set a Lock screen, Google Device
Protection is automatically enabled.
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NOTE If you reset your Google Account password, it can take 24 hours for the
password reset to sync with all devices registered to the account.

Before resetting your device:
1. Verify that the information you want to keep has transferred to your storage

ared.

2. Login to your Google Account and confirm your user name and password.

To reset your device:

1. From Settings, tap ) General management > Reset > Factory data reset.
2. Tap Reset and follow the prompts to perform the reset.

3. When the device restarts, follow the prompts to set up your device.

Google Device Protection

When you signin to a Google Account on your device and set a Lock screen, Google
Device Protection is enabled. This service protects your phone from unauthorized
factory data resets by requiring your Google account information to verify your
identity. For more information, visit samsung.com/us/support/answer/ANS00083965.

Enable Google Device Protection

Adding a Google Account to your device and setting a Lock screen automatically
activates Google Device Protection.

Disable Google Device Protection

To disable Google Device Protection, you can either remove all Google Accounts from
the device or remove the Lock screen.

Toremove Google accounts:

1. From Settings, tap (@) Accounts and backup > Manage accounts > [Google
Account].

2. Tap Remove account.
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Toremove a secure Lock screen:

1. From Settings, tap (7)) Lock screen > Screen lock type.

2. Tap either Swipe or None.

Accessibllity

There are accessibility settings for people who need help seeing, hearing, or
otherwise operating their device. Accessibility services are special features that
make using the device easier for everyone. For more information about Accessibility
for Samsung products, please contact us at accessibility@sea.samsung.com.

Recommended for you

View alist of accessibility features that you are using and some recommended
features you may want to enable.

-+ From Settings, tap {3 Accessibility > Recommended for you to view
recommendations.

TalkBack

Use special controls and settings that let you navigate without needing to see the
screen.

1. From Settings, tap €9 Accessibility > TalkBack.
2. Tap to enable the feature, and tap an option to customize:

+ TalkBack shortcut: Choose a shortcut to quickly turn on TalkBack.

+ Settings: Configure TalkBack settings to better assist you.
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Spoken assistance

Use special controls and settings that let you navigate without needing to see the
screen.

1. From Settings, tap €9 Accessibility > Spoken assistance.
2. Tap to enable the feature, and tap an option to customize:

» Speak keyboard input aloud: The device will read aloud what you type on the
keyboard.

+ Audio description: If available, automatically chose the audio soundtrack with
an audio description while watching videos.

Visibility enhancements

You can configure Accessibility features to assist with visual aspects of your device.

Colors and clarity
You can adjust the colors and contrast of text and other screen elements for easier
viewing.
-z From Settings, tap 3 Accessibility > Visibility enhancements and tap an option:
* Choose an available display mode and tap Apply:
- Default: Default display mode.

- High contrast: Dark mode, High contrast fonts, High contrast keyboard,
Remove animations, and Reduce transparency and blur are turned on.

- Large display: Font size and Screen zoom are increased and Bold font and
Highlight buttons are turned on.

* High contrast fonts: Adjust the color and outline of fonts to increase the
contrast with the background.

* High contrast keyboard: Adjust the size of the Samsung keyboard and
change its colors to increase the contrast between the keys and the
background.

* Highlight buttons: Show buttons with shaded backgrounds to make them
stand out better against the wallpaper.
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* Color inversion: Reverse the display of colors from white text on a black
background to black text on a white background.

* Color correction: Adjust the color of the screen if you find it difficult to see
some colors.

* Remove animations: Remove certain screen effects if you are sensitive to
motion.

* Reduce transparency and blur: Reduce visual effects on dialogs and menus
to make them easier to see.

Size and zoom

You canincrease the size of supported screen elements and create shortcuts for
accessibility features on your device.

* Magnification: Use exaggerated gestures such as triple-tapping, double
pinching, and dragging two fingers across the screen.

* Pointer size and color: Use a large pointer for a connected mouse or
touchpad (accessories not included).

* Font size and style: Configure screen fonts.

* Screen zoom: Configure the screen zoom level.

Hearing enhancements

You can configure settings to help you interact with your device’'s sounds, including
captioning, sound balance, and hearing aid support.

© From Settings, tap €3 Accessibility > Hearing enhancements and tap an option:

* Real time text: Activate real-time text (RTT) calling.
* Live Transcribe: Use the microphone to record speech and convert it to text.
* Caption preference: Configure closed caption and subtitle services.

* Sound notifications: Receive alerts when the device detects a baby crying or
a doorbell.
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* Mono audio: Switch audio from stereo to mono.

* Left/right sound balance: Use the sliders to adjust the left and right balance
for connected audio and device speakers.

Interaction and dexterity

You can configure Accessibility features to assist with limited dexterity when
interacting with your device.

Alternate input

You can control your device using different kinds of inputs and controls.

s From Settings, tap 9 Accessibility > Interaction and dexterity and tap an option:
* Universal switch: Control your device with your customized switches.

* Assistant menu: Improve device accessibility for users with reduced
dexterity.

* Voice Access: Voice Access lets you control your device hands-free. Use
voice commands to open apps, tap buttons, scroll, type, and more.

Interactions

You can simplify the motions needed to respond to notifications and alarms.

o From Settings, tap €3 Accessibility > Interaction and dexterity and tap an option:

* Interaction control: Customize areas of screen interactions, hardkeys, and
the keyboard.

Touch settings

You can adjust your screen to be less sensitive to taps and touches.

* Touch and hold delay: Select a time interval for this action.

* Tap duration: Set how long an interaction must be held to be recognized as
atap.

* Ignore repeated touches: Set a time duration in which to ignore repeated
touches.
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Mouse and physical keyboard

Configure settings for a connected mouse and physical keyboard.

o From Settings, tap &9 Accessibility > Interaction and dexterity and tap an option:

* Auto action after pointer stops: Automatically click an item after the pointer
stops over it.

+ Sticky keys: When you press a modifier key like Shift, Ctrl, or Alt, the key stays
pressed down, which allows you to enter keyboard shortcuts by pressing
one key at atime.

* Slow keys: Set how long a key must be held before it is recognized as a press,
which helps avoid accidental key presses.

* Bounce keys: Set how long to wait before accepting a second press from the
same key, which helps avoid accidentally pressing the same key multiple
times.

Advanced settings

You can customize additional accessibility features and services for your device.

_‘Q’_ TIP Additional accessibility apps may be downloaded from the Google Play store.

Accessibility shortcuts
2 From Settings, tap {9 Accessibility > Advanced settings and tap an option:

* Accessibility button: Choose an accessibility shortcut for the Accessibility
button.

* Side and Volume up keys: Configure selected Accessibility features to open
by quickly pressing the Side and Volume up keys and Volume up keys at the
same time.

* Volume up and down keys: Configure selected services to turn on when you
press and hold the Volume up and Volume down keys for three seconds.
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Notifications
oz From Settings, tap 9 Accessibility > Advanced settings and tap an option:

* Flash notification: Flash either the camera light or the screen when you
receive notifications or when alarms sound.

+ Time to take action: Choose how long to show messages that ask you to take
action, but are visible only temporarily (like notifications).

Installed apps

You can install additional assistance services for your device.
o From Settings, tap €3 Accessibility > Installed apps.

NOTE Additional accessibility services are listed and configured here after they
are installed.

About Accessibility

Legal and license information about the current Accessibility software is available in
Settings.

o+ From Settings, tap {9 Accessibility > About Accessibility. The following information
is available:
* Version: View the current Accessibility software version.

* Open source licenses: View information for the open source licenses used for
Accessibility.

Contact us

If you have any questions or problems while using your device contact Samsung
support through Samsung Members. Access community forums, error reports,
remote support and more (if supported by your service provider).

o From Settings, tap €3 Accessibility > Contact us.
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Other settings

Configure features on your device that make it easier to use.

Help

View the user manual for your device.

o From Settings, tap (7| Help.

Medical info

Emergency responders and others can access your medical info even when your
device is locked.

1. From Settings, tap ('1 Safety and emergency > Medical info.

2. Enter your allergies, current medication, and other medical information you
would like to be available in an emergency.

3. Tap Save.

Labs

Try experimental features. Some features may not work correctly with all apps.

1. From Settings, tap '~ Advanced features > Labs.

2. Tap to enable an experimental feature.

About tablet

View information about your device, including current status, legal information,
hardware and software versions, and more.

1. From Settings, tap (i J) About tablet to view your model number, serial number,
and IMEl information.

2. Tap additional items to view more information about your device.

_‘Q’_ TIP You can view your device's FCC ID from (i) About tablet > Status information.

=N
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Samsung Knox

Samsung Knox is Samsung's security platform and is a mark for a Samsung device
tested for security with enterprise use in mind. Additional licensing fee may be
required. For more information about Knox, please refer to: samsungknox.com/en.
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Learn more

Videos

youtube.com/samsungcare

0 Samsung Care+

samsung.com/us/support

¥ Talk to an agent

Contact us on Facebook Messenger
Find us on Facebook

Follow us on Twitter
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Legal information

READ THIS INFORMATION BEFORE USING YOUR MOBILE DEVICE.

Arbitration Agreement - This Product is subject to a binding arbitration agreement
between you and SAMSUNG ELECTRONICS AMERICA, INC. ("Samsung”). You can opt out of
the agreement within 30 calendar days of the first consumer purchase by emailing
optout@sea.samsung.com or calling 1-800-SAMSUNG (726-7864) and providing the
applicable information.

The full Arbitration Agreement, Standard One-year Limited Warranty, End User License
Agreement (EULA), and Health & Safety Information for your device are available
online:

Tablet:

- English: samsung.com/us/Legal/Tablet-HSGuide
* Spanish: samsung.com/us/Legal/Tablet-HSGuide-SP

This information can also be found on the device in the "About device” or "About
phone” or "About tablet” section, for example:

- Settings > About phone or About device or About tablet > Legal information >
Samsung legal

+ Or,search "Legal’

If your device required Federal Communications Commission (FCC) approval, you can
view the FCC certification by opening Settings > About phone or About device or About
tablet > Status information.

131


mailto:optout@sea.samsung.com?subject=Arbitration
https://www.samsung.com/us/Legal/Tablet-HSGuide
https://www.samsung.com/us/Legal/Tablet-HSGuide-SP

Legalinformation

Restricting children’s access to your
nobile device

Your mobile device is not a toy. Do not allow children under the age of 3 to play with it
because they could hurt themselves or others or damage the device. If parents
choose to allow children 3 or older to use the device, they should make sure that there
is adequate supervision to guard against injury or damage and use of services that
mMay increase data costs or other charges.

Parental control settings should be enabled to ensure that children do not have
access to services or content not approved by the parent. Routinely check this device
to ensure itis working properly and is safe for children to use.

Samsung Electronics America, Inc.

Address:

85 Challenger Road
Ridgefield Park
New Jersey 07660

Phone: 1-800-SAMSUNG (726-7864)
Internet: samsung.com

©2023 Samsung Electronics Co., Ltd. Other company and product names mentioned
herein may be trademarks of their respective owners.

Manufactured under license from Dolby Laboratories. Dolby, Dolby Atmos, and the
double-D symbol are trademarks of Dolby Laboratories.

HE HEVCAdvance”

Covered by Patents at patentlist.nevcadvance.com

Some multimedia (audio/video) files contain Digital Rights Management (DRM)
technology to verify you have the right to use the files. Preloaded apps on your
device may not be compatible with DRM-protected files.

Screenimages are simulated. Appearance of device may vary.
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Legalinformation

Descriptions are based on the device’'s default settings. Some content may differ
depending on carrier, model, or software.

The actual available capacity of the internal storage is less than the specified
capacity because the operating system and default applications occupy part of the
storage. The available capacity may change when you upgrade the device.

Please check with your service provider to verify qualifying services/features.
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